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• Intro to MSP430 Architecture
• Intro to Tools and I/O
• Intro to Low-Power with the MSP430

Agenda
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MSP430
Ultra-low Power
MSP430MSP430

Ultra-low Power
8-bit

Performance

Measurement
Utility Metering
Portable Instrumentation

TMS470
ARM7TDMI
TMS470TMS470

ARM7TDMI

C2000
150 MIPS
C2000C2000

150 MIPS

Industry Standard
Automotive
General Purpose

High-Performance
Motor Control 
Digital Power Supply

TI Microcontroller Portfolio

16/32-bit

DSP

$25B MICRO TAM
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MSP430 Products

F/C41x
F42x0

Fx42x
F44x

Pe
rf

or
m

an
ce

Future
Development
Sampling
Production

Device
5xx
• 25 MIPS+
• 128-256 KB 
• USB-ZigbeeTM

F21x1
F22xx

F13x-F16x

2xx
• 16 MIPS
• 1-120KB
• 500 nA

Stand By

1xx
• 8 MIPS
• 1-60KB Fx43x

F20xx

F12xx
F/C11xx

F543x

F23x-F26x

FG563x

F = Flash
C = Custom ROM

Signal Chain on Chip F26xx

F/CG46xx

F5xx

Integration

4xx-ASSP
• 8 MIPS
• 4-120KB
• LCD Driver
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What Is The MSP430?
Ultra-low Power 

0.1uA power down
0.8uA standby mode
250uA / 1MIPS
<1us clock start-up
<50nA port leakage
Zero-power BOR

Ultra-Flexible
1k-128kB ISP Flash
14-100 pin options
USART,I2C, Timers
10/12/16-bit ADC 
DAC, OP Amp, LCD driver
Embedded emulation

FLASHClock

Digital
Peripheral

RISC
CPU
16-bit

MAB  16

MDB  16

RAM

Analog
Peripheral

. . .

. . .
ACLK

SMCLK

JT
A

G
/D

eb
ug
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Address
Modes
Destination Instructions

MSP430

Other
Special instructions to learn
Complicated and inefficient 

Orthogonal Architecture
• Clear and consistent with no exceptions
• Compiler efficient
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015

16

16-bit ALU

R8
R9
R10
R11
R12
R13
R14
R15

R4
R5
R6
R7

R3/CG
R2/SR
R1/SP
R0/PC

16

015

16

16-bit ALU

R8
R9
R10
R11
R12
R13
R14
R15

R4
R5
R6
R7

R3/CG
R2/SR
R1/SP
R0/PC

16

16-bit RISC CPU
• Single-cycle register file

4 special purpose
12 general purpose
No accumulator bottleneck

• RISC architecture
27 core instructions
24 emulated instructions
7 addressing modes

• Memory-to-memory         
atomic addressing

• Bit, byte and word 
processing
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;-------------------------------------------------------
BIN2BCD; Binary Number (R12) -> Packed BCD (R14|R13)
;-------------------------------------------------------

mov     #16,R15        ; Loop Counter
clr     R14            ; 0 -> RESULT MSD
clr     R13            ; 0 -> RESULT LSD

BIN1    rla     R12            ; Binary MSB to carry
dadd    R13,R13        ; RESULT x2 LSD
dadd    R14,R14        ; MSD
dec     R15            ; Through?
jnz     BIN1           ; Not through
ret

;-------------------------------------------------------
BIN2BCD; Binary Number (R12) -> Packed BCD (R14|R13)
;-------------------------------------------------------

mov     #16,R15        ; Loop Counter
clr     R14            ; 0 -> RESULT MSD
clr     R13            ; 0 -> RESULT LSD

BIN1    rla     R12            ; Binary MSB to carry
dadd    R13,R13        ; RESULT x2 LSD
dadd    R14,R14        ; MSD
dec     R15            ; Through?
jnz     BIN1           ; Not through
ret

• Access to many single-cycle registers
• Useful for calculation intensive functions

Deep Register File RISC Advantage
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; 16-bit addition                       Code/Cycles
5405           add.w  R4,R5              ; 1/1
529202000202   add.w  &0200,&0202        ; 3/6

; 8-bit addition
5445           add.b  R4,R5              ; 1/1
52D202000202   add.b  &0200,&0202        ; 3/6

; 16-bit addition                       Code/Cycles
5405           add.w  R4,R5              ; 1/1
529202000202   add.w  &0200,&0202        ; 3/6

; 8-bit addition
5445           add.b  R4,R5              ; 1/1
52D202000202   add.b  &0200,&0202        ; 3/6

Bytes, Words And CPU Registers

• Use CPU registers for calculations and dedicated 
variables

• Same code size for word or byte
• Use word operations when possible
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84 bits / 24 cycles

Memory

; MSP430
mov    ADC10MEM,RAM

; MSP430
mov    ADC10MEM,RAM

; Other MCU
movf    ADCRESH,W
movwf   RAMH
bsf     STATUS,0x20
movf    ADCRESL,W
bcf     STATUS,0x20
movwf   RAML

; Other MCU
movf    ADCRESH,W
movwf   RAMH
bsf     STATUS,0x20
movf    ADCRESL,W
bcf     STATUS,0x20
movwf   RAML

10-bits
10-bit
ADC

48 bits / 6 cycles

Do You Use A 10+ Bit ADC?
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Register Mode mov.w R10,R11
Single cycle

Indexed Mode mov.w 2(R5),6(R6)
Table processing

Symbolic Mode mov.w EDE,TONI
Easy to read code, PC relative

Absolute Mode mov.w &EDE,&TONI
Directly access any memory location

Indirect Register Mode mov.w @R10,0(R11)
Access memory with pointers

Indirect Autoincrement mov.w @R10+,0(R11)
Table processing

Immediate Mode mov.w #45h,&TONI
Unrestricted constant values

Seven Addressing Modes

Atomic
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• Non-interruptible memory-to-memory operations
• Useable with complete instruction set

Memory
B

; MSP430
add    A,B

; MSP430
add    A,B

; Pure RISC
push    R5
ld      R5,A
add     R5,B
st      B,R5
pop     R5

; Pure RISC
push    R5
ld      R5,A
add     R5,B
st      B,R5
pop     R5

A

Atomic Addressing

B=B+A
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; Other MCU 
;   movlw  HIGH Tab

movwf  PCLATH
movwf  DispVal,W
call   Tab
movwf  PORTB
goto   Continue

Tab addwf  PCL,F
retlw  B’00111111’
retlw  B’00000110’
retlw  B’01011011’
retlw  B’01001111’
retlw  B’01100110’
retlw  B’01101101’
retlw  B’01111101’
retlw  B’00000111’
retlw  B’01111111’
retlw  B’01101111’

Continue 

; Other MCU 
;   movlw  HIGH Tab

movwf  PCLATH
movwf  DispVal,W
call   Tab
movwf  PORTB
goto   Continue

Tab addwf  PCL,F
retlw  B’00111111’
retlw  B’00000110’
retlw  B’01011011’
retlw  B’01001111’
retlw  B’01100110’
retlw  B’01101101’
retlw  B’01111101’
retlw  B’00000111’
retlw  B’01111111’
retlw  B’01101111’

Continue 

MCU A

E C

D

BF

G

A

G

B
C
D
E
F

P
or

t

Write Less Code

;   MSP430 
;   mov.b Tab(DispVal),P1OUT
Tab DW    0063Fh  

DW    04F5Bh  
DW    06E66h  
DW    0077Ch  
DW    0677Fh  

;   MSP430 
;   mov.b Tab(DispVal),P1OUT
Tab DW    0063Fh  

DW    04F5Bh  
DW    06E66h  
DW    0077Ch  
DW    0677Fh  

238 bits / 48 cycles

128 bits / 6 cycles
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• Immediate values -1,0,1,2,4,8 generated in hardware
• Reduces code size and cycles

• Completely Automatic!

4314           mov.w   #0002h,R4        ; With CG

40341234       mov.w   #1234h,R4        ; Without CG

4314           mov.w   #0002h,R4        ; With CG

40341234       mov.w   #1234h,R4        ; Without CG

Effect Of The Constant Generator
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24 Emulated Instructions

• Easier to understand - no code size or speed penalty
• Replaced by assembler with core instructions

• Completely Automatic!

4130           ret                 ; Return (emulated) 

4130           mov.w  @SP+,PC      ; Core instruction

4130           ret                 ; Return (emulated) 

4130           mov.w  @SP+,PC      ; Core instruction
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; Format I Source and Destination
5405 add.w  R4,R5 ; R4+R5=R5 xxxx
5445 add.b  R4,R5 ; R4+R5=R5 00xx

; Format II Destination Only
6404 rlc.w  R4                
6444 rlc.b  R4                

; Format III There are 8(Un)conditional Jumps
3C28 jmp    Loop_1 ; Goto Loop_1

Op-Code S-Register As D-RegisterAd B/W

Three Instruction Formats

Op-Code As D/S-RegisterB/W

Op-Code 10-bit PC offsetCondition
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Format I                
Source, Destination 

Format II   
Single Operand 

Format III              
+/- 9bit Offset 

Support 

add(.b) br jmp clrc 
addc(.b) call jc setc 
and(.b) swpb jnc clrz 
bic(.b) sxt jeq setz 
bis(.b) push(.b) jne clrn 
bit(.b) pop(.b) jge setn 
cmp(.b) rra(.b) jl dint 
dadd(.b) rrc(.b) jn eint 
mov(.b) inv(.b)  nop 
sub(.b) inc(.b)  ret 
subc(.b) incd(.b)  reti 
xor(.b) dec(.b)   
 decd(.b)   
 adc(.b)   
 sbc(.b)   
 clr(.b)   
 dadc(.b)   
 rla(.b)   
 rlc(.b)   
 tst(.b)   

51 Total Instructions
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Unified Memory Map
• Absolutely no paging
• Supports code agility
• ISP Flash

Self programming
JTAG
Bootloader

FLASH

Main Segments
(x) 512B

Boot Loader

RAM

Info Segments 

Peripherals

Interrupt VectorsFFFF

0000

// Flash In System Programming
FCTL3 = FWKEY;         // Unlock
FCTL1 = FWKEY | WRT;   // Enable
*(unsigned int *)0xFC00 = 0x1234; 

// Flash In System Programming
FCTL3 = FWKEY;         // Unlock
FCTL1 = FWKEY | WRT;   // Enable
*(unsigned int *)0xFC00 = 0x1234; 
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Programming ‘F2131 8KB Flash?
• fFTG = ________?
• tWORD = ______?
• Program word or byte = _____________?
• Please see datasheet!
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Reset Conditions
• RST/NMI configured in the reset mode
• I/O pins are switched to input
• Watchdog timer powers up as active watchdog
• Other peripheral modules are disabled
• Status register (SR) is reset
• Program counter (PC) is loaded with (0FFFEh)

• Always refer to Family users guide
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ATC Board
• Default jumper

settings 

• MSP430FG4619
‘4619 JTAG

• MSP430F2013
‘2013 JTAG
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IAR Kickstart Tour
• Instructor-led 

tour of Kickstart
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Getting Started Lab1: Blinky
• Blink the LED with assembly code
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Lab1: Flash The LED First Program
#include  "msp430x20x3.h”

ORG    0F800h                  ; Program start
RESET     mov.w  #280h,SP                ; Stack

mov.w  #WDTPW+WDTHOLD,&WDTCTL  ; Stop watchdog
bis.b  #01h,&P1DIR            

Mainloop  xor.b  #01h,&P1OUT            
Delay     dec.w  R15                     

jnz    Delay                   
jmp    Mainloop                

ORG    0FFFEh                  ; RESET vector
DW     RESET                   
END     

#include  "msp430x20x3.h”

ORG    0F800h                  ; Program start
RESET     mov.w  #280h,SP                ; Stack

mov.w  #WDTPW+WDTHOLD,&WDTCTL  ; Stop watchdog
bis.b  #01h,&P1DIR            

Mainloop  xor.b  #01h,&P1OUT            
Delay     dec.w  R15                     

jnz    Delay                   
jmp    Mainloop                

ORG    0FFFEh                  ; RESET vector
DW     RESET                   
END     



© 2006 Texas Instruments Inc, Slide 25

Lab1: Step-by-Step
• Connect the FET interface to the PC USB port
• Connect the JTAG cable to the  ‘2013 JTAG port on 

the board
• Connect the BATT jumper on your board
• Launch IAR
• Create new workspace

File → New → Workspace

• Create new project
Project → Create new project → Click “OK” on dialogue pop-up
Name the project (Lab1) and click “Save”



© 2006 Texas Instruments Inc, Slide 26

Lab1: Step-by-Step (cont.)
• Configure the project

Project → Options
– Select MSP430F2013 from “Device” drop down menu (DDM)
– Click “Assembler Only” project
– Highlight “Debugger” in the Category list
– Select “FET Debugger” from the “Driver” DDM
– Highlight “FET Debugger” in the Category list
– Select the “TI USB” in the “Connection” section
– Click OK

• Create the source file
File → New → File
Type source from slide
Click save, name it, and save it
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Lab1: Step-by-Step (cont.)
• Add source file to the project

Project → Add Files
Select “Assembler Files” from “Files Of Type” DDM
Select your file and click Open

• Click the “Debug” button in IAR:  
• Name and save workspace when prompted
• Click “OK” about the Stack Plug-in
• Click “Go” in IAR:  
• Your done!  Click “Stop Debugging” button: 
• Pull the power jumper
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Lab1: For Future Reference

• Previous instructions summarized section 2.2.2 of 
FET User’s Guide (navigate from START menu)
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• Intro to MSP430 Architecture
• Intro to Tools and I/O
• Intro to Low-Power with the MSP430

Agenda
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Embedded Emulation
• Debug real time in system

No application resources used
Full speed                  
Breakpoint                          
Single step                           
Complex trigger
Trace

• Security Fuse
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MSP-FET430
USB FET Interface:

JTAG Interface Target Board

$149.00MSP430FG43x, MSP430x43xMSP-FET430U100
$149.0080-pin MSP430x43x/MSP430x44xMSP-FET430U80
$149.00MSP430x13x/x14x/x15x/x16xMSP-FET430U64
$149.00MSP430x11x1A, MSP430x12x/x1xx2MSP-FET430U28
PriceProduct FamilyPart Number

$99.00MSP430MSP-FET430UIF
PriceProduct FamilyPart Number

Interface only without target board: 
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JTAG Interface Target Board

MSP-FET430
Parallel FET Interface:

$99.00MSP430F43x/44xMSP-FET430P440
$99.00MSP430FG43x, MSP430x43xMSP-FET430P430
$99.00MSP430x41x, MSP430FE42x, MSP430FW42xMSP-FET430P410
$99.00MSP430x13x/x14x/x15x/x16xMSP-FET430P140
$99.00MSP430x11x1A, MSP430x12x/x1xx2MSP-FET430P120
PriceProduct FamilyPart Number

$49.00MSP430MSP-FET430PIF
PriceProduct FamilyPart Number

Interface only without target board: 
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eZ430-F2013

Spy Bi-Wire
Interface

All target pins accessible

USB Powered

LED

Emulator
Removable 

Target Board

MSP430F2013



© 2006 Texas Instruments Inc, Slide 34

IAR Kickstart IDE
• MSP-FET430 IDE

Assembler/linker
4kB IAR compiler
Parallel or USB Interface
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Which IDE Do I Use?
• IAR Embedded workbench
• TI Code Composer Essentials
• Rowley, Quadravox, Image Craft, GCC, Others
• Check Third-Party website for complete list

• Most have 30-day trials
• Check the Yahoo! user group for recommendations
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www.ti.com/msp430
• User’s Guide                                    
• Datasheets                                                      
• 100+ Application reports                                
• 500+ Code examples 
• Complete 3rd party listing
• Errata                                      
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Code Examples!
• Reduce development time
• Over 1000 free examples
• Provided in C / assembler
• Use standalone 
• Use as a template for

your next project
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WDTCTL = 0x5A80;

WDTCTL = 0xA580;

WDTCTL = 0xA540; // Hold watchdog

WDTCTL = WDTPW + WDTHOLD; // Hold watchdog

WDTCTL = 0x5A80;

WDTCTL = 0xA580;

WDTCTL = 0xA540; // Hold watchdog

WDTCTL = WDTPW + WDTHOLD; // Hold watchdog

Why Use Standard Definitions?

• Which code line holds the watchdog?
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Getting Started Lab2: I/O Overview
• Configure Port1 and Port2 of the MSP430FG4619

P1.0 as input with interrupt enabled
P1.0 interrupt on H-L transition
P2.1 as output to turn on LED

• Inside of P1ISR
Clear pending interrupt flag
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Port GPIO
bis.b  #010h,&P1DIR    
bis.b  #010h,&P1SEL    

bis.b  #010h,&P1DIR    
bis.b  #010h,&P1SEL    

bis.b  #001h,&P1DIR     
bis.b  #001h,&P1OUT     

bis.b  #001h,&P1DIR     
bis.b  #001h,&P1OUT     

Input Register PxIN 

Output Register PxOUT 

Direction Register PxDIR 

Function Select PxSEL

Interrupt Edge PxIES 

Interrupt Enable PxIE 

Interrupt Flags PxIFG 
P1 and P2 only
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Lab2: Step-by-Step
• Move JTAG cable to ‘4619 and connect BATT jumper
• Launch IAR
• Open previous workspace when prompted
• Create new project as before

Project → Create new project → Click “OK” on dialogue pop-up
Name the project (Lab2) and click “Save”

• Configure the project
Project → Options

– Select MSP430FG4619 from “Device” drop down menu (DDM)
– Highlight “Debugger” in the Category list
– Select “FET Debugger” from the “Driver” DDM
– Highlight “FET Debugger” in the Category list
– Select the “TI USB” in the “Connection” section
– Click OK
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Lab2: Step-by-Step (cont.)
• Add source file to the project

Project → Add Files
Select “Getting_Started_Lab2.c” and click Open

• Complete the code
• Click the “Debug” button in IAR:  
• Click “Go” in IAR:  
• Test and debug your code
• When done, click “Stop Debugging” button: 
• Pull the power jumper
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Getting Started Lab2: I/O
void main(void)
{
WDTCTL = WDTPW + WDTHOLD; // Stop WDT
FLL_CTL0 |= XCAP14PF;     // Configure load caps
P2DIR = ____;             // Set P2.1 to output direction
P1IES = ____;             // H-L transition
P1IE = ____;              // Enable intererupt
_EINT();                  // Enable interrupts
while (1);

}

// P1 interrupt service routine
#pragma vector=PORT1_VECTOR
__interrupt void P1ISR (void)
{

…………
P1IFG &= ~____;         // Clear P1IFG

}

void main(void)
{
WDTCTL = WDTPW + WDTHOLD; // Stop WDT
FLL_CTL0 |= XCAP14PF;     // Configure load caps
P2DIR = ____;             // Set P2.1 to output direction
P1IES = ____;             // H-L transition
P1IE = ____;              // Enable intererupt
_EINT();                  // Enable interrupts
while (1);

}

// P1 interrupt service routine
#pragma vector=PORT1_VECTOR
__interrupt void P1ISR (void)
{

…………
P1IFG &= ~____;         // Clear P1IFG

}



© 2006 Texas Instruments Inc, Slide 44

Getting Started Lab2 – Solution
void main(void)
{
WDTCTL = WDTPW + WDTHOLD; // Stop WDT
FLL_CTL0 |= XCAP14PF;     // Configure load caps
P2DIR = BIT1;             // Set P2.1 to output direction
P1IES = BIT0;             // H-L transition
P1IE = BIT0;              // Enable interrupt
_EINT();                  // Enable interrupts
while (1);

}

// P1 interrupt service routine
#pragma vector=PORT1_VECTOR
__interrupt void P1ISR (void)
{

…………
P1IFG &= ~BIT0;         // Clear P1IFG

}

void main(void)
{
WDTCTL = WDTPW + WDTHOLD; // Stop WDT
FLL_CTL0 |= XCAP14PF;     // Configure load caps
P2DIR = BIT1;             // Set P2.1 to output direction
P1IES = BIT0;             // H-L transition
P1IE = BIT0;              // Enable interrupt
_EINT();                  // Enable interrupts
while (1);

}

// P1 interrupt service routine
#pragma vector=PORT1_VECTOR
__interrupt void P1ISR (void)
{

…………
P1IFG &= ~BIT0;         // Clear P1IFG

}
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• Intro to MSP430 Architecture
• Intro to Tools and I/O
• Intro to Low-Power with the MSP430

Agenda
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Ultra-low Power Activity Profile

Always-on 

On demand
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Performance on Demand

Interrupt

DCO

• Immediate-stable clock start for reaction to events
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Off
All 

Clocks Off
0.1uA

Off
All 

Clocks Off
0.1uA

Stand-by
DCO off
ACLK on
0.8uA

Stand-by
DCO off
ACLK on
0.8uA

LPM3
RTC function
LCD driver
RAM/SFR 
retained

CPU Off
DCO on

ACLK on
35uA

CPU Off
DCO on

ACLK on
35uA

<6us

<6us

Ultra-low Power Clock Control

LPM0 LPM4
RAM/SFR 
retained

Active
DCO on

ACLK on
250uA

Active
DCO on

ACLK on
250uA
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MSP430x11x/12x Basic Clock

R2/SR

Reserved CSCG1 SCG0 ZNGIECPU
OFF

OSC
OFFV
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32768Hz 1- 8MHz

‘1xx Basic Clock XTAL Options

• Most MSP430 applications use a 32768 XTAL

XOUT

XIN

XOUT

XIN

XOUT

XIN

XOUT

XIN
ROSC

100K
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‘1xx Basic Clock DCO Control



© 2006 Texas Instruments Inc, Slide 52

Does the DCO Have Jitter?

• What are the benefits of mixing two frequencies?
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• Periodic loop can adjust DCO
• If Rosc = 100k then DCOCLK ~ 2MHz

‘1xx DCO Calibration

DCOCLK

DCOR

P2.5/
Rosc

VCC

DCOxRSELx
n

n+1

VCC

100k

2MHz

4096Hz 
ACLK

// Partial SW FLL Code
if (488 < Compare )   // DCO too fast
DCOCTL--;

else  DCOCTL++;        // DCO too slow

// Partial SW FLL Code
if (488 < Compare )   // DCO too fast
DCOCTL--;

else  DCOCTL++;        // DCO too slow
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Automatic DCO 
Stabilization

‘4xx FLL

• OSCfault fail-safe for LFXT1, DCO and XT2
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Low Power Mode Configuration

Active Mode    0  0  0  0     ~ 250uA

LPM0           0  0  0  1     ~  35uA

LPM3           1  1  0  1     ~ 0.8uA

LPM4           1  1  1  1     ~ 0.1uA

bis.w   #CPUOFF,SR        ; LPM0  bis.w   #CPUOFF,SR        ; LPM0  

R2/SR

Reserved CSCG1 SCG0 ZNGIECPU
OFF

OSC
OFFV
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Interrupt Vectors – ‘F11x1
SOURCE  FLAG  INTERRUPT ADDRESS PRIORITY 
Power-up 
ext. Reset 
Watchdog 

WDTIFG  Reset 0FFFEh 15, highest 

NMI 
Osc. Fault 
Flash violation 

NMIIFG 
OFIFG  
ACCVIFG 

(non)-maskable 
(non)-maskable 
(non)-maskable 

0FFFCh 14 

   0FFFAh 13 
   0FFF8h 12 
Comparator_A CAIFG maskable 0FFF6h 11 
Watchdog timer WDTIFG maskable 0FFF4h 10 
Timer_A CCIFG0 maskable 0FFF2h 9 
Timer_A CCIFGx maskable 0FFF0h 8 
   0FFEEh 7 
   0FFECh 6 
   0FFEAh 5 
   0FFE8h 4 
I/O Port P2 P2IFGx maskable 0FFE6h 3 
I/O Port P1 P1IFGx maskable 0FFE4h 2 
   0FFE2h 1 
   0FFE0h 0, lowest 

 

FLASH

(x) 512B
Segments

8-bit Peripherals

Boot Loader

RAM

(2) 128B

16-bit Peripherals

Interrupt Vectors
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ISR hardware - automatically
PC pushed 
SR pushed
Interrupt vector moved to PC
GIE,  CPUOFF, OSCOFF and SCG1 cleared
IFG flag cleared on single source flags

reti - automatically
SR popped - original
PC popped

Prior to ISR
SP

Item1
Item2

PC
SR

SP

SP

Item1
Item2

Item1
Item2

PC
SR

Interrupt Processing
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ORG     0F000h        
RESET     mov.w   #300h,SP      

mov.w   #WDT_MDLY_32,&WDTCTL
bis.b   #WDTIE,&IE1      
bis.b   #01h,&P1DIR   

Mainloop  bis.w   #CPUOFF+GIE,SR 
xor.b   #01h,&P1OUT 
jmp     Mainloop

WDT_ISR   bic.w   #CPUOFF,0(SP)
reti

ORG     0FFFEh  
DW      RESET                 
ORG     0FFF4h                    
DW      WDT_ISR                   

ORG     0F000h        
RESET     mov.w   #300h,SP      

mov.w   #WDT_MDLY_32,&WDTCTL
bis.b   #WDTIE,&IE1      
bis.b   #01h,&P1DIR   

Mainloop  bis.w   #CPUOFF+GIE,SR 
xor.b   #01h,&P1OUT 
jmp     Mainloop

WDT_ISR   bic.w   #CPUOFF,0(SP)
reti

ORG     0FFFEh  
DW      RESET                 
ORG     0FFF4h                    
DW      WDT_ISR                    

Item1
Item2

PC
SR=0018

SP

SP

Item1
Item2

PC
SR

Item1
Item2

PC
SR=0008

SP
Item1
Item2

Low Power Modes In Assembler
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Low Power Modes In C

Item1
Item2

PC
SR=0018

Item1
Item2

Item1
Item2

PC
SR

Item1
Item2

PC
SR=0008

void main(void)
{ 
WDTCTL = WDT_MDLY_32;  
IE1 |= WDTIE;         
P1DIR |= 0x01;              

for (;;)
{
_BIS_SR(CPUOFF + GIE);
P1OUT ^= 0x01;          

}
}
#pragma vector=WDT_VECTOR
__interrupt void watchdog_timer(void)
{

_BIC_SR_IRQ(CPUOFF);  
}

void main(void)
{ 
WDTCTL = WDT_MDLY_32;  
IE1 |= WDTIE;         
P1DIR |= 0x01;              

for (;;)
{
_BIS_SR(CPUOFF + GIE);
P1OUT ^= 0x01;          

}
}
#pragma vector=WDT_VECTOR
__interrupt void watchdog_timer(void)
{

_BIC_SR_IRQ(CPUOFF);  
}SP

SP

SP
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100% CPU Load

Interrupts Control Program Flow

UART
RX
TX

// Polling UART Receive
for (;;)
{
while (!(IFG2&URXIFG0));
TXBUF0 = RXBUF0;
}

// Polling UART Receive
for (;;)
{
while (!(IFG2&URXIFG0));
TXBUF0 = RXBUF0;
}

// UART Receive Interrupt
#pragma vector=UART_VECTOR
__interrupt void rx (void)
{
TXBUF0 = RXBUF0;
}

// UART Receive Interrupt
#pragma vector=UART_VECTOR
__interrupt void rx (void)
{
TXBUF0 = RXBUF0;
}

0.1% CPU Load

9600 baud
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100% CPU Load

Software Functions >> Peripherals

MCU
P1.2

// Endless Loop 
for (;;) 
{
P1OUT |= 0x04;  // Set 
delay1();
P1OUT &= ~0x04; // Reset
delay2();
}

// Endless Loop 
for (;;) 
{
P1OUT |= 0x04;  // Set 
delay1();
P1OUT &= ~0x04; // Reset
delay2();
}

// Setup output unit
CCTL1 = OUTMOD0_1; 
_BIS_SR(CPUOFF);

// Setup output unit
CCTL1 = OUTMOD0_1; 
_BIS_SR(CPUOFF);

Zero CPU Load
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• OPA with shutdown can be 20x lower total power

0.01uA = Shutdown 
20uA = Active
---------------------------
0.06uA = Average

1uA = Quiescent
1uA = Active 
-----------------------
1uA = Average

Power Manage External Devices
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Power Manage Internal Peripherals

P1OUT |= 0x02;                     // Power divider
CACTL1 = CARSEL + CAREF_2 + CAON;  // Comp_A on
if (CAOUT & CACTL2)
P1OUT |= 0x01;                    // Fault
else
P1OUT &= ~0x01;        

P1OUT &= ~0x02;                    // de-power divider 
CACTL1 = 0;                        // Disable Comp_A

P1OUT |= 0x02;                     // Power divider
CACTL1 = CARSEL + CAREF_2 + CAON;  // Comp_A on
if (CAOUT & CACTL2)
P1OUT |= 0x01;                    // Fault
else
P1OUT &= ~0x01;        

P1OUT &= ~0x02;                    // de-power divider 
CACTL1 = 0;                        // Disable Comp_A

Comparator_A
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How To Terminate Unused Pins?
• Unused port pins Px.0 – Px.7?

Set as output direction avoids floating gate current.

• XT2IN, XT2OUT?

• Please see last page of chapter 2 in user’s guide.
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Principles For ULP Applications
• Maximize the time in LPM3
• Use interrupts to control program flow
• Replace software with peripherals
• Power manage external devices
• Configure unused pins properly
• Efficient code makes a difference
• Every unnecessary instruction executed is a portion 

of the battery wasted that will never return.
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Getting Started Lab3: Low-Power
• Lab2 has been converted to use LPM3 instead of the 

while(1) wait loop
• Open IAR and create a new project as before
• Add the file “Getting_Started_Lab3.c” to the project
• Download the code as before
• Disconnect the JTAG interface
• Measure the current through the PWR1 jumper
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Getting Started Lab3 – Solution
while(1)
{
_BIS_SR(LPM3_bits);     // Enter LPM3
if ((P1IN & 0x01) == 0)
P2OUT ^= 0x02;        // Toggle P2.1 using exclusive-OR

}

// P1 interrupt service routine
#pragma vector=PORT1_VECTOR
__interrupt void P1ISR (void)
{
unsigned volatile int i;
for (i=10000; i>0; i--);  // Debounce delay
P1IFG &= ~BIT0;           // Clear P1IFG
_BIC_SR_IRQ(LPM3_bits);   // Clear LPM3 bits from 0(SR)

}

while(1)
{
_BIS_SR(LPM3_bits);     // Enter LPM3
if ((P1IN & 0x01) == 0)
P2OUT ^= 0x02;        // Toggle P2.1 using exclusive-OR

}

// P1 interrupt service routine
#pragma vector=PORT1_VECTOR
__interrupt void P1ISR (void)
{
unsigned volatile int i;
for (i=10000; i>0; i--);  // Debounce delay
P1IFG &= ~BIT0;           // Clear P1IFG
_BIC_SR_IRQ(LPM3_bits);   // Clear LPM3 bits from 0(SR)

}
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Lab3: Low-Power Questions
• What is the current through the PWR1 jumper?
• Why were the I/Os configured as they were?
• Why was LPM3 used?
• Look in the header file to see how LPM3_bits is 

defined
• What further low-power improvements could be 

made?
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Lab3: Low-Power Answers
• What is the current through the PWR1 jumper?

About 1.4 uA

• Why were the I/Os configured as they were?
Unused I/O must be configured as outputs, otherwise, floating gate 
current will be seen.  The outputs were then set to values so as not to 
contend with other on-board circuitry

• Why was LPM3 used?
No clocks are needed. LPM3 leaves on the 32768Hz running and shuts 
down all other clocks.

• Look in the header file to see how LPM3_bits is 
defined

SCG1+SCG0+CPUOFF

• What further low-power improvements could be 
made?

LPM4 could be used.  A timer could be employed for the debounce.
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Lab3: Going Further
• Convert the code to use LPM4 and re-measure the 

current.  What is it now?
Should be about .3 uA

x00geoff
Text Box
SLAP114
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